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Definitions/Acronyms/Abbreviations 

Term/Acronym Definition 

Center Participating Center 

CRF Case Report Form 

DMC Data Management Center (Amherst, USA) 

Patient Binder Compilation of all available CRFs for a patient 

 

Overview 

DFexplore is a remote data entry tool that allows Centers to enter their patient trial data electronically. 

Remote data entry eliminates the need for faxing most CRFs to the IBCSG. This manual explains the 

procedures for using DFexplore and DFsend. Use this document and the trial-specific Data Manager’s 

Manual for instructions on how to complete and submit data. 

 

Getting Access to DFexplore and DFsend 

Download (recommended) 

Instructions for downloading DFexplore and DFsend can be found on the IBCSG DF Resource web page 
at https://www.ibcsgdmc.org/ibcsg/df/downloads.view. 

DFnavigator 

If you are unable to download DFexplore, it can also be accessed via the web at https://dfp.fstrf.org. 

DFsend is not available via the web. If accessing DFexplore via DFnavigator, you must fax any non-CRF 

data into the system. Please see “DFexplore Fax Numbers”, available on the IBCSG DF Resource web 

page, for available fax numbers. You must also enter the sever name each time you use DFnavigator. The 

server name is “explore.fstrf.org” 

The instructions in this manual apply to both the downloaded application and the web-based access.  

Logging in to DFexplore  

The DMC provides you with your initial Login Name and Password. You will be prompted to change your 

password the first time that you log in.  

Your password should not be shared with anyone and is intended for use by only the individual 
named on the account.  

If you have lost or forgotten your password, either: 

1. Contact datafax.user.support@fstrf.org or  

2. Go to: https://www.ibcsgdmc.org/ibcsg/df/ and click on Support/Reset Password.  

A new password will be sent to you within 2-3 business days. 

To log in: 

1. Double click on the DFexplore icon on the desktop to start DFexplore. The Login box appears. Verify 
the “DFdiscover Server” field displays “explore.fstrf.org”. If not, type it in. 

2. Enter your Login Name and Password. 

 
 

https://www.ibcsgdmc.org/ibcsg/df/downloads.view
https://dfp.fstrf.org/
mailto:datafax.user.support@fstrf.org
https://www.ibcsgdmc.org/ibcsg/df/
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NOTE regarding Proxy Server: If your IT department has installed a proxy server (to filter requests sent 

to other servers on the internet) click the gear button to the right of the ' DFexplore Server' name to register 

the proxy server. You may need to contact your IT department for the necessary information as your firewall 

must allow connections to explore.fstrf.org. The port number used for DFexplore’s secure communication 

is port 443. 

 

However, if you do not use a proxy server, you should connect directly to our DF server at explore.fstrf.org 
and leave the “Use Proxy Server” box unchecked. 

 

3. The Login box contains a Help button for troubleshooting: 

 

4. Click “Login.” You have officially logged in to DFexplore and a list of trials that you can access is 
displayed. 

 

5. Double click the appropriate trial or select a trial and click on “OK” or select the trial and press enter on 
the keyboard. 

http://explore.fstrf.org/
http://explore.fstrf.org/
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Preferences 

Once logged in, DFexplore has a number of options to view and navigate through the data. To view the 

options, select “File” -> “Preferences” from the menu bar or the shortcut list on the left side of the Dashboard. 

 

This opens up a Preferences window. There are many options you can choose to set your screens to your 

preferences. In order to be consistent with the details in this manual, the following settings are 

recommended. 

  

 

 

 

Date picker: This allows you to select date from a calendar 

next to any date field. 
 

Display metadata editor: This allows the Query, Reason, 

Missing Value, and Help-Study box to appear on the right 
side of the screen.  If not checked, the Help box is not 
displayed. 

 

Auto open/close and split screen: data top, image bottom: 

This allows DFexplore to display the image of any faxed CRF 
at the bottom of the screen and the data entered in the 
database at the top of the screen, so both are visible at the 
same time. If there is no fax image, you see the database on 
the full screen. 

 

Default View:  Set the Dashboard as your default view, to 

see a real time overview of your Center’s data/query 
submission and quality. 

 

Color: This enables the color features in DFexplore. NOTE: 

For older trials (55 and below), you may want to select white 
or blank for the background. 

Auto Logout: This is set, by default, to 5 minutes. You can 

choose an auto logout time up to 30 minutes. 

. 
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Dashboard View 

Upon logging in, the Dashboard View is displayed. Dashboard View provides shortcut access to common 

DFexplore views and a snapshot summary of the current database status. It shows basic study metrics 

graphically as well as a menu of operations for commonly performed tasks.  

 

 
 
View Shortcuts - In the left column, shortcuts are provided to commonly accessed functionality and menu 

items (e.g. data entry, review queries, etc.).  

 
Status Summary - Presented in tabular and chart forms, the status summary is an overview of the records 

and metadata in the current database.  

 
The table cells and chart legends are interactive. Double-clicking any item builds a task to retrieve those 

filtered data records and presents them in Data View. Task options can be modified in the confirmation 

dialog before switching to Data View. If the table cell or chart legend item is related to a query, the Queries 

View is presented; if it is related to a reason, the Reasons View is presented. 

 

In the table of query categories and statuses, rows are categories (type of query such as missing, 

incomplete, etc.) and statuses (pending, outstanding, and resolved) are columns. By default, categories 

(and hence rows) that have counts greater than 0 are displayed. To display all table rows, check “All” in the 

table header for the Query Category column. 

 

To select queries for a specific category and status, double-click the matching cell in the table. To select 

queries for a specific category and all statuses, double-click the category label in the first column of the 

matching row. In the task confirmation dialog, you can choose if the task records are displayed in Data View 

or Queries View.  
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Data Entry Details 

Data entry screens can be accessed two ways: 
1. Select “View” from the Toolbar and then “Data”. 

 

 
 
OR 
 
2. From the Dashboard, select “Data entry and review” from the shortcuts on the left: 

 

 
 

The entry screen consist of six sections (Patient binder, Data entry screen, Query box, Reason box, 

Missing value box, and Help box): 
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Patient Binder 

The Patient Binder lists all patients enrolled for that trial, at your Center. Each patient is represented by a 

Patient ID and, to the left, a head icon. 

  
 

Double clicking on the patient icon opens the patient visits and CRFs, ordered by visit (e.g., Baseline, 

Treatment Cycles, Follow-up, SAEs etc.).  

  

Data Entry Screen 

Data is entered on these screens. Each screen is a page of a CRF. Trials that were set up in iDataFax and 

migrated to DFexplore (IBCSG 55 and lower) retain the old backgrounds: 
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The background color can be changed from black to white by going to File  Preference Background 

Options. The white background may aid in viewing the field colors more easily. 

 

Trials set up in DFexplore have a background where colors and shading are used to aid in navigating the 

questions. 

  
If any data is submitted to DFexplore via DFsend or fax, a split screen is displayed where both the fax and 

the data entry screen are viewable.  
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If the image cannot be seen, you have to select the toggle display box  at the bottom right of the data 

entry window. 

 

 
  

 

If there are multiple pages of an image, these can be pulled up by selecting the numbered box at the bottom 

right side of the data entry screen. 

 

 
 
 
  

Number of fax images 

Image display box 
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The image box expands showing a list of images saved in the database. Click on each one to view each 

page. 

 

 

Query Window 

This window is for query management (creation, replying and resolving) 

Reason Window 

This window is used to provide a reason when a change is made to saved data. This can also be used to 

provide additional information or clarification to a data field.  

Missing Value Window 

This window is for reporting a value that is unknown, unattainable, etc. 

Help-Study Window 

This window provides help at the study, page (plate) and field level. 



IBCSG DFexplore User Manual    
Version 2.0 May 2022 

 Page 11 of 27 

Color Coding 

DFexplore uses different colors to provide information about each field. The chart below explains each color 

that is used in DFexplore. 

The color coding chart can be found under the Help tab in the toolbar. 

         

 

Entering Data 

Randomization 

Within 24 hours of patient randomization via the IBCSG Registration/Randomization system, the patient’s 

binder appears in DFexplore. 

Forms Order 

All forms for the life of the trial are available in the patient binder. Some forms may not pertain to a specific 

patient’s treatment and therefore, do not need to be completed (for example an SAE form). Do not enter or 

save changes on CRFs that are in visit periods that have not yet occurred. If this happens, data is requested 

for the future visits. 

  

Example: A patient is scheduled to come in for the six (6) Month Follow-up visit. If data is submitted for the 

18-Month Follow-up instead, the QC report requests all of the data from the time between the 6-Month and 

18-Month Follow-up visits. 

Data Entry 

1. Double click the appropriate patient icon to open the binder.  
NOTE: If someone already has this patient binder open (e.g., DMC managing data) you will not be able to 

enter data. A dialogue box pops up stating the patient is locked by another user and asks if you want to 

review the data in View Only Mode. 
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2. Double click on the appropriate visit. The visit expands and all forms available for that visit are 
displayed.  
 

 

3. Click on the appropriate form. The form opens in the data window.  

4. Each field should be navigated by using the Tab key so auto-populations and warnings, if applicable, 

can pop up and prompt you to either enter or correct data. This dialog box explains the inconsistency 

and prompts you to correct the problem.  

 

 

5. You can decrease the number of queries from the Data Management Center if you correct the data 

before it is saved. 

6. If you do not correct the inconsistency, the page can still be saved. The inconsistency is brought to the 

Center’s attention again once the DMC has reviewed the page and added a query. 

7. Save the page when all necessary questions are answered. You must save each page after data entry 

is complete. When the record is saved it is automatically sent to the DMC for review. There are two (2) 

different save modes: 
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 Final: The record can be saved as Final when there are no outstanding fields, queries, or 

inconsistencies on the page. If there are outstanding problems on the record (any red or blue fields), 

the “Final” box is gray and you can’t click it. Records saved as Final appear in the patient binder 

with a head icon colored green. 

 Incomplete: Save the record as Incomplete when there are outstanding data, queries, or 

inconsistencies that still must be resolved. Records saved as Incomplete appear in the patient 

binder with a head icon colored red. 

 

 

NOTE: Records saved as Incomplete are submitted to the DMC with the inconsistencies. The Center 
may return to the record and add additional information at any time. If changes are saved, the 
amended form is re-reviewed at the DMC. See the Correcting Data section for more 
information. 

NOTE: Illegal values on the record can only be saved as Incomplete.  For example a value outside the 
normal range or a partial date. 

NOTE: The Pending option appears on the Save Bar, but cannot be used.  

View Only Pages 

Pages marked “view mode” at the bottom of the data screen are pages you cannot make changes to. The 
page may be for internal use at the DMC or it may be that all pages are locked because another user has 
this patient’s binder open already. 
 

Entering a Reason for Changing Data 

Once data has been saved, it cannot be changed without entering a reason for that change. If you change 
data in a previously saved field, a dialogue box appears prompting you to enter a reason: 
 

 
 
Enter the reason for change and click OK. If you did not mean to make the change, click Revert to Old 
Value. If you click OK, the field turns orange (pending DMC review) and the reason is viewable to the right 
of the screen: 
 

 
 



IBCSG DFexplore User Manual    
Version 2.0 May 2022 

 Page 14 of 27 

Once the reason is reviewed by the DMC, it is approved and the field turns green, or it is rejected and a 
query is added, turning the field blue. 

Clarifying an Answer 

When completing a CRF, you may provide an explanation for unusual or missing data (e.g., question was 
not asked, procedure done at another institution, lab values abnormal due to chemotherapy, etc.) by using 
the Reason for Data Value Box. This additional information may eliminate the need for a query. To enter a 
reason: 
1. Click on the field for which a reason is being provided. 

2. Click the green + button in the Reason box title bar. This launches a text box.  

 

 
 
OR 
 
1. Click on the Field option in the top toolbar and select “Add Reason for Data Value”. This also launches 

a dialogue box.  
 

 
 

2. Type the reason in the text box.  

3. Click OK to save the reason. The field turns orange, indicating that a reason has been entered and 

must be reviewed by the DMC (pending reason). If the DMC approves the information in the Reason 

box, the field turns green. If the DMC has additional questions, a query is issued or the reason is 

rejected, and the field turns blue. 

4. Save the record before navigating off the current plate. A warning message will pop up if you try to 

move to a new record without saving the changes. 

Additional Options 

After a reason has been saved onto a field, it can be either changed or deleted.  

1. Click on the field in where the reason was entered.  

2. In the toolbar at the top of the screen, click on “Field” tab.  

3. Select “Edit Reason for Data Value” to change the reason (in the dialogue box that pops up) or select 

“Delete Reason for Data Value” to remove the reason from the field. 
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Missing Values 

If an answer to a question is unknown, not done or unattainable, this can be noted using the Missing Value 
function. Fields can be marked as missing one of two ways: 
 

Option 1 

1. Click on the field in question.  

2. In the toolbar at the top of the screen, click on “Field” tab.  

3. In the drop down menu, Click “Set Field Missing’ and choose the appropriate reason the field is not 

answered. This changes the field to green. 

 

 

If at any time you wish to enter data in these fields, follow the steps above and then select “No Code (reset)” 

to change the field back to its original color and enter data.  Data cannot be entered if the field has been 

marked as a missing value. 

Option 2 

1. Click on the field in question.  

2. Click on the green + sign in the Missing Value box.  

3. Select the reason the question cannot be answered. This changes the field in question to green. 

4. Click apply at the bottom right of the screen. 

 
 
If at any time you wish to enter data in this field, you need to remove the missing value coding. To change 

the field back to its original color and enter data, click on the red minus sign then click on the Apply button. 

 

 
 
NOTE: Fields that have been marked with the missing value do not allow data to be entered. The code 

must be deleted/reset in order to enter any data. 
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Partial Dates 

Partial dates are considered illegal (red field) by DFexplore. However, if the date is viewed as valid (not 

required for eligibility, progression, or serious adverse event reporting) by the DMC, it is accepted and the 

field changes to green. 

 

If the month and year are known but the day is unknown, 00 can be entered for the day. For example, if the 

date is May 2011, 00/05/2011 should be entered in DFexplore. 

 

If only the year is known and the day and month are unknown, 00 should be entered for both the day and 

month. For example, if the date is 2011, 00/00/2011 should be entered in DFexplore. 

 

If the entire date is unknown, the field should be marked as a Missing Value. Do not enter an unknown 

date as 00/00/0000. 

 

Dates are reported in dd/mm/yyyy format in DFexplore and on the CRFs. 

 

Logging Out of DFexplore 

1. Save any changes to the current page as final or incomplete. 

2. If changes are not saved, DFexplore displays a dialog box prompting you to save any changes.  

3. Select “File”. 

4. Select “Exit”. 

You can also log out from the Dashboard View by clicking the “Quit DFexplore” tab on the bottom left. 
 

 
 

1. If after a period of inactivity you are automatically logged out, and the Auto Logout box appears. To 

return to DFexplore, click “Login again.” To exit DFexplore, click “Exit.” 

 

 

2. If you were automatically logged out, a dialog box appears the next time you log in to the same trial. 

You may return to the same page you were on before you were logged out. Click “Resume” in the 

dialog box to return to the last page. If there were unsaved changes on this page, the dialog box 

identifies the appropriate Patient ID, assessment number, and page number. If you do not want to 

return to the last page click “Ignore”. 
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Switching Between Trials 

If your Center participates in more than one trial in DFexplore, you may close out of one trial and open 
another by doing the following: 

1. Save any changes to the current page as final or incomplete. 

2. If changes are not saved, DFexplore displays a dialog box prompting you to save any changes.  

3. Select “File”. 

4. Select “Close Study” or “New Study”. If in Dashboard view, you can also do this by clicking on the 

“Open new study” tab on the bottom left”. 

 

5. This displays the initial Lists of Trials. You can now open another DFexplore trial by double clicking on 

that trial. 

You can have more than one trial or multiple instances of the same trial open at the same time in 
DFexplore. Multiple sessions of DFexplore can be opened to look at different patients. 

DFsend 

Some information cannot be entered electronically in DFexplore. Some examples are: 

 Quality of Life/Patient-completed questionnaires 

 Reports: Pathology, Laboratory, Autopsy, etc.  

 Medical Review query replies: These are queries generated by the IBCSG Medical Reviewers and sent 

via email. They must be completed by hand. 

This information must be submitted by DFsend (preferred) or fax. Once received and entered by the DMC, 

these forms/reports are viewable, but not editable, in DFexplore. 

Using DFsend 

Be sure you have downloaded DFsend from https://www.ibcsgdmc.org/ibcsg/df/downloads.view . 

If you are using DFnavigator instead of DFexplore, you cannot use DFsend. You must send this type of 

information via fax. The fax numbers are available on the DF Support page at 

https://www.ibcsgdmc.org/ibcsg/df/documentation.view . 

 

1. Login with the same server (explore.fstrf.org), username and password you use for DFexplore. 

https://www.ibcsgdmc.org/ibcsg/df/downloads.view
https://www.ibcsgdmc.org/ibcsg/df/documentation.view
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2. Document selection – The files must be saved in PDF format. Drag and drop one or more PDFs onto 

the DFsend application box or click the Add button to use the standard file selection dialog.  

NOTE: All pages must have the patient’s Randomization ID Number and Center Code written clearly on 

them or we are unable to identify the pages and they cannot be routed to the patient’s file.  

For Pathology and other reports, all other patient identifiers must be crossed out. Each trial has label 

templates that can be printed and affixed to these types of reports, which can help the DMC identify them. 

These label templates are available on the IBCSG web site or the CTSU/Alliance website. 

3. Transmit - Click the Send button to send the selected PDFs to the study server. Enter your username 

and password again for verification. 

4. Confirmation - On completion, DFsend displays the transmission status of each PDF file. A green 

checkmark indicates a successful transmission where as a red X indicates a failed transmission. 

5. Tracking - Each PDF transmission is logged by: username, date, time and transmission status. This 

information is readily available when viewing pages in the DFexplore electronic patient binders. Past 

transmissions can be reviewed in the DFsend application by selecting the option “Show log”. 

Quality Control (QC) Reports 

 
Quality Control Reports are distributed on a regular basis via e-mail to the individual Center or Coordinating 

Group who, in turns forwards them to the Centers. The Report contains a list of overdue forms and, for 

some trials, a patient summary status. With DFexplore you can view overdue queries and CRFs in real time 

and have a chance to answer them before the next QC Report is generated.  

For older trials Centers’ outstanding queries may also be sent. You can either answer the queries on paper 

and send the response back via DFsend or fax, or answer the queries directly in DFexplore. You do not 

need to do both.  

We recommend you check for and answer outstanding queries regularly, so data can be clean. See 

Answering Queries below for more information. 
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Checking for Queries 

1. Click the “View” drop down menu on the tool bar. 

2. Select Queries. 

 

 

 

3. Alternatively, queries may be selected from the Dashboard View in one of two ways. Clicking on the 

Outstanding queries column takes you to the individual queries on the data field. 

 

 

 
4. Using View Queries or clicking on “Review Queries” on the left, shows queries as follows: 

4.1. A list of all queries for all your patients on the trial are displayed. Queries with a green icon have 

been resolved and require no further action. Queries with a blue icon require a reply from you. 

Pending queries are indicated with an orange icon. These are awaiting DMC approval. 

4.2. You can narrow the list of queries are displayed (e.g., all queries, only outstanding ones, etc.).  

 Select the “Show” drop down menu on the tool bar.  

 Select the desired option. 

 

 

All 
queries 
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4.3. Double clicking on an individual query line opens the patient binder to the CRF page that has the 

query and the field where the query is placed. The query can then be answered. 

4.4. To return back to Query View, click on the “Return to Query View” bar located below the patient 

binder. 
 

  
 

5. When you are done with Query View, you can return to the patient binder by selecting “View” from the 

tool bar and then click on “Data”. 
 

Answering Queries 

Fields that have queries associated with them are highlighted blue. If there is more than one query on a 

field, it is noted as follows: 

 

 
 
In this example, there are three queries that need to be answered.The Query box lists all 3 queries: 

 

Outstanding 
queries only 

Query 1 
 

Query 2 
 

Query 3 
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All three queries need to be answered. There are three ways to reply to queries. 
1. Correct the data.  

If the query is asking for missing data, or a data correction, you can correct the data in the field and 

save the page. If you do this, you do not need to answer the query. The DMC reviews the data change 

and resolves the query if answered adequately by this change or addition. 

2. Use the Query dialogue box 

 Click on the field being queried. The query is displayed in the Query box on the right side of the 

window.  

 

 

 Type your answer in the Reply box. 

 
 

 Click “Apply” at the bottom of the screen. The field turns orange. When the DMC reviews and 

resolves the query, the field turns green. If further clarification is needed, the DMC writes a new 

query which changes the field back to blue and requires another response from the Center. 

3. Reply to Queries from the toolbar: 

 Click on the field being queried. 

 Select “Reply to query” from the Field tab. 
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 A dialogue box is displayed: 

 

 Enter a reply.  

 Click “OK”. After resolving the query, the field turns orange. When the DMC reviews and resolves 

the query, the field turns green. If further clarification is needed, the DMC writes a new query which 

changes the field back to blue and requires another response from the Center. 

 
Data Field Section 

To select specific data fields go to the “select” tab on the menu bar. Choose the option “by data fields”. This 

brings up a tool box for field selection options. This is how you pull up a single patient binder or an entire 

Center. 

 

  

List View 

List View allows you to view data records for a selected CRF page in spreadsheet form for all your patients. 

Each row in the spreadsheet is a data record and each column is a data field. This data can be searched 

and sorted. In list view, the data can be exported (Click File  Export Data) to various Excel formats. 
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You can access list view from Dashboard View by clicking on the Review Data and Metadata tab. 

 

 
 
List View can also be accessed from the toolbar at the top; Select “View” and then “List”. This opens up a 
window showing all CRF pages available for that trial.  
 

 
 

When one page is selected, a table replaces the data window. The table lists each field on the page and 

the data entered in DFexplore for each patient. 

 

 
 

No data can be changed or entered in List View. “View Mode” appears at the bottom of the screen to remind 

the DM of this. 

Any column can be reordered in ascending or descending order by clicking on the field in the top row. 

Double clicking on any field in the table takes you back to Data View where the page/data can be seen and 

amended. 
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The fields can also be color coded to match the data (blue for fields with queries, green for resolved field, 

etc.). To activate this option, choose “File” from the tool bar and “Preferences” from the drop-down menu. 

Under “List View” click on “Fill cell with field color” and then click “OK”. 

 

 
 
All fields on that page are displayed in a line; one line per patient. To reduce the number of fields seen, 

click “Select” from the toolbar and then “Field Selection”. A pop up box with all the fields is displayed.  

 
Click on “Select None” and then individually select the fields you want to review. Then click “OK”. The 

screen shows only the fields you selected.  

 

Searching a Field in List View 

The Search function in List View can be used to find records with a specific data value or attribute. 

1. While in List View, select the plate you would like to search. 

2. Choose “Select” from the toolbar and then “Search”. 

3. Click on the “…” button next to the Field # box, and choose the field you would like to search. 

4. Specify the data you are searching for, check the “Filter” box and click “Filter”. A dialogue box pops 

up with the results of the search. To view these filtered records, click “Apply”.  

The example below is a search on an Enrollment Form. It is looking for all patients that were randomized 

on 01/May/2018.  
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The records you selected appear in the window.  
 

 
 

Reports 

DFexplore has many reports that can help present overall pictures of compliance, accrual, etc.  

To run a report, select “Reports” from the “View” tab or select “Run Reports” from the Dashboard View. A 

list of report options appears.  

Some reports are accessible based on role permissions. You may not be able to run these reports and they 

will not be in the list when you open the Reports menu.   

Click on a report option. Select the data options in the drop down to specify the report. Once the options 

are specified, click “Run”.  

 
 
The reports are interactive and clickable output can be manipulated and displayed in diverse ways without 

re-executing the report. They can be pulled off the DFexplore screen (click on the report and drag it off 

DFexplore window) and you can continue to work in the database. Reports can be printed and saved in 

different formats. 
 

 



IBCSG DFexplore User Manual    
Version 2.0 May 2022 

 Page 26 of 27 

If you select Options on the right side of the report, additional features can be viewed. 
 

 
 
 
Reports can be saved in PDF, Excel, and HTML formats. 

Saving Data from DFexplore 

You can save blank forms for each patient to use as a worksheet, or copies of completed forms for reference 

as PDF files. A single page or the entire binder can be saved. 

NOTE: Files saved as PDFs are not viewable by the DMC. Saved files are to be used for Center reference 
only.  

1. Open the appropriate patient binder. 

2. Select “File”. 

3. Select “Save as PDF”. 

4. Select the appropriate options (see Printing from DFexplore for descriptions of most of the options) 

 

5. After desired options have been selected, click on the button in the Output File section to choose the 
location to save the file. 

6. Click “Save”. 
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Printing from DFexplore 

While saving data as a PDF is more environmentally friendly and can reduce the risk of HIPPA violations, 

you also have the option to print blank forms for each patient to use as a worksheet, or copies of completed 

forms for reference. A single page or the entire binder can be printed.  

1. Open the appropriate patient binder. 

2. Select “File”. 

3. Select “Print”. 

4. Select the appropriate options: 

4.1. The Selection Criteria section allows you to determine how much of the patient binder will be 
printed: 

Blank CRF books: Allows you to print blank CRFs by patient, visit or page (plate) 

Data and images 

 Current Plate: Prints only the page that is open in the data window. 

 Current Visit: Prints all pages in the visit period that is open in the data window. 

 All Open Visits: Prints all pages in every open visit period (i.e., all CRFs for that assessment 
can be seen).  

 Current Subject: Prints all pages in the selected patient binder. 

4.2. The Print Options section allows you to determine what types of images are printed: 

Blank plates (pages): Prints a blank copy of the selected pages. 

NOTE: The Patient ID and Month/Cycle/Visit Number are completed on every printed page, 

even if “Blank Pages” is selected. Verify that the correct patient binder is selected before 

printing.  

Data records: Prints pages with data. The data and primary (data submitted by DFsend or fax) 

images can be printed side by side.  

Images: Prints any images submitted by DFsend or Fax. If more than 1 image is held on the same 

page, one image is assigned as primary and all others are secondary. If you want to print all images 

for that page, select “all images”. 

 Color Option: Clicking this box applies the colors for each field (e.g. blue for outstanding 

 query, red for required/illegal field, etc.) 

5. Click “Print”. 

User Support and Contact Information 

For questions related to trial-specific issues, contact the DMC at the appropriate email address. 

  

DFexplore resources, support, and documentation are available at: https://www.ibcsgdmc.org/ibcsg/df/ 

For fax confirmation and technical questions about DFexplore or connection issues, contact DMC user 

support at datafax.user.support@fstrf.org or via phone at +716-834-0900 ext. 7302. 

 

 

https://www.ibcsgdmc.org/ibcsg/idfaccess/
mailto:datafax.user.support@fstrf.org

